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PinMuxing
Introduction

Chapter 1
PinMuxing

This document describes the PinMuxing tool, which is a pin management tool for QorlQ-based system-on-chips (SoCs).
This tool is part of the QorlQ Configuration and Validation Suite (QCVS) product.

This chapter contains the following sections:
e Introduction on page 3
* Preliminary background on page 3

* Working with PinMuxing tool on page 3

1.1 Introduction

The PinMuxing tool gives an overview of the SoC pins and their allocations to peripherals.
It is designed to help the board designers and low-level platform programmers to:
* Use the correct and optimal number of pins needed for a custom board design

* Program the platform (for example, reset configuration word (RCW)) in sync with the pins used in a board design

1.2 Preliminary background

This section explains the problem that led to the development of the PinMuxing tool.

A QorlQ SoC has a limited number of pins that can be used to implement various peripherals (for example, DUART, PCI
Express, SDHC, and SATA). Each peripheral requires several signals (for example, DUART RX or DUART TX), each
corresponding to a pin.

Usually (and especially in low-end SoCs), the number of pins is small as compared to the potential peripherals that could be
implemented. In hardware, this limitation is translated into multiple peripheral signals being multiplexed (muxed) over the
same pin. This muxing poses a series of problems for a board designer that needs to implement a set of peripherals within
the SoC pin constraints.

In addition, the platform programming (such as, RCW) must be in sync with the pins being used by the peripheral signals.
Therefore, the need arose for a tool that can manage all this without requiring to take a deep dive into several different
documents.

1.3 Working with PinMuxing tool

The PinMuxing tool brings a user experience that is focused on what peripherals need to exist in a custom board design,
hiding the underlying pin details.

At the same time, the user is prevented from making incorrect settings (for example, choosing peripherals that do not have
enough free pins to be implemented). In addition, after each operation, the user gets the following information about the
current pin allocations:

» All pins being used by an assigned peripheral
* Pins that can no longer be used (being used by some assigned peripherals)

* Pins that are being shared among multiple assigned peripherals
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If required, the user can take a deep dive into the pin details to get the following information:
* Number of pins allocated for each assigned peripheral

* Pin properties (such as, package location, direction, and electrical properties)

This section contains the following subsections:

* Creating a project with PinMuxing component on page 4

* Using PinMuxing component on page 5

* Adding a new PinMuxing component to a project on page 9

* Generating a PinMuxing report on page 10

1.3.1 Creating a project with PinMuxing component

The PinMuxing tool is implemented as a component in QCVS; therefore, first you need to create a QCVS project with the
PinMuxing component.

Follow the steps below to create a QCVS project with the PinMuxing component:
1. Launch QCVS.

2. Select File > New > QorlQ Configuration Project. The New QorlQ Configuration Project wizard starts, displaying
the Create a QorlQ Configuration Project page.

3. Specify the project name in the Project name text box, as shown in the figure below.
[ E MNew Qord() Configuration Project 4 | = Iﬁ‘

Create a QorlQ Configuration Project

Choose the location for the new project

Specify project
name

Project name: pin_rnuxmg_prc_ie-:d

| Use default location

QK cf St Sirne L dsTiECh. QovE

Figure 1. Specify project name

4. Click Next. The Devices page appears.

5. Choose a device (an SoC) to work with, as shown in the figure below.
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PR fiew QorlC) Configuration Project ERERCIE X |

Devices

Select the processer you would like to use

Processor to be used:

L5101

Choose an - Lﬂst
SoC

Chaete b silicen revisien: | 20 -
Figure 2. Choose a device

NOTE
See QCVS Release Notes for details on which QorlQ SoCs are supported by the PinMuxing tool.
6. Choose a device revision. If only one revision is available, it is automatically chosen.
7. Click Next. The Toolset selection page appears.
8. Select Pin Muxing Configuration, as shown in the figure below.

m Mew QorlQ Configuraticn Project

Toolset selection

Choose what do you want to configure

Components to be selected

type filter text

a [ | Components
[] DDR Memory Controller Configuration
[] Device Tree Editor

Select PinMuxing [] PBL - Preboot Loader RCW configuration

component Pin Muxing Configuraticn
[] SERDES Configuration Tool

Figure 3. Select PinMuxing component

9. Click Finish to create the project.

1.3.2 Using PinMuxing component

After creating the project, you can use the PinMuxing component to perform pin management.
The PinMuxing component also stores the pin settings. Follow these steps to use the PinMuxing component:

1. Select in Project Explorer the QCVS project you just created.
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2. Expand the Components node in the Components view.

3. Right-click the PinMuxing component and choose Inspector from the shortcut menu, as shown in the figure below.

(5 Project Explorer £2 = 0

¥

Joy

Newly created
project

4 28 pin_muxing_project
(= Documentation
(= Generated_Code
(= Sources

% ProcessorExpert.pe

ts. Components - pin_muxing... &2 < O

cmay v
4 (= Generator_Configurations
& LS1021A v2_0_Cnf
» (= 0Ss
4 (= Processors
&P SoC:LS1021A v2. 0

4 (= Components

PinMuxing o8 PinMuxl:PinMux

component Show PinMuxing

component GUI

Inspector
Inspector - Pinned

Code Generation

Figure 4. Open PinMuxing component

The Component Inspector view opens, showing the graphical user interface (GUI) of the PinMuxing component, as
shown in the figure below.
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Assign/remove

S0C peripherals/pins peripherals/pins

Pin Musing Configuration Toolbar buttons
Modules Assigned Modules
Name Description Direction  Location  Power Supply Name Description Direction  Location  Power Supply
) A Anslog Signals 4 Clocking Clecking
Assigned ock DIFF_SYSCLK System Clock Ditferential (positive) | am2L ovoo
peripherals/ ve) 1 AM21 v DIFF_SYSCLK B System Clock Differential inegative) | AN2L ovoo
pins (green) regative) 1 AN OVDD RTC Real Time Clock I G19 ovDD
eal Time Clock 1 OVDD SYSCLK System Clock I AP2L ovoD
System Clock 1 OV 4 GPIO Genersl Purpese Input/ Output
. DOR-Clocking DR Clocking GPIOL_00 Genersl Purpose Input/ Output 0 B10 ovoo
Assignable DOR-interface-1 DR SORAM Memary Intesface 1
peripherals/ DOR-Interface:2 DDR SORAM Memory Interface 2 Last assigned peripheral
il Debu: Debuy
pins (black) oab 9 Det ] {vellow)
DUART DUART
SOHC eSOHC
Ethemet M1 Ethemet Management Interface 1
Ethernet-MI-2 Ethernet Management Interface 2 i
6PIO General Purpase Input/Output Eiminated Modules
. (3 e
Una_ssglahle IEEE1583 FEEELSES Name Description Direction  Location  Power Supply
pfarlpherals/ « GPIO Genenl Purpose Input/Output
pins (gray) Intermupts Interrupt Controller GPIO3_30 General Purpose Input/ Output 0 619 ovoo
JUAG JIAG FC Integrated Flash Controller
por-config Power-On Reset Configuration
QsPl Quad SP1
Serdes-l SeDes1
Serdese2 SerDes 2 Peripheral eliminated by last
. S ktafece assigned peripheral (yellow)
System-Control System Control
Trust Trust
USB-PHY.1-and-2 USBPHY1 &2
USB-PHY-1-and-2 USBPHY1 &2

Figure 5. Parts of PinMuxing component GUI

The subsections below describe the major parts of the PinMuxing component GUI:
* Modules panel on page 7

* Assigned Modules panel on page 7

* Eliminated Modules panel on page 8

* Toolbar buttons on page 8

1.3.2.1 Modules panel

This panel provides a list of all the peripherals that use the pins of the chosen SoC.

Some of the peripherals may be using shared pins; whereas, others may have dedicated pins. Using the right and left arrow
buttons (shown in Figure 5. Parts of PinMuxing component GUI on page 7), you can assign or remove peripherals from this
list. You also have the option to add or remove pins by double-clicking their names. This seems to be more user friendly. The
pins can be assigned as an entire module or as individual signals.

When you assign or unassign a peripheral (see the Assigned Modules panel), the color of the peripheral changes, as follows:
* Black: The peripheral can be assigned, it means, all the pins needed by the peripheral signals are available

» Green: The peripheral has been assigned and can be found in the Assigned Modules list (see the Assigned Modules
panel)

» Gray: The peripheral cannot be assigned as some of the pins it requires are being used by other assigned peripherals.
This is the point where PinMuxing actually comes into action: a pin can be used only once. The gray-colored peripherals
can be found in the Eliminated Modules list (see the Eliminated Modules panel).

1.3.2.2 Assigned Modules panel

This panel provides a list of peripherals that have been assigned.

They correspond to the green-colored items in the Modules panel list. An assigned peripheral can be put back into the Modules
panel list (it means, it can be removed) by using the left arrow button.

NOTE
The last assigned peripheral is colored in yellow. In addition, the peripherals eliminated (see
Eliminate Modules panel) by the last assigned peripheral are also colored in yellow.

QCVS PinMuxing Tool User Guide, Rev. 4.7, 10/2016
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The figure below shows an overview of the Assigned Modules panel.

Assigned peripheral with pin details
Assigned Modules

Marme Description Direction Location Power Supply
— 4| Clocking Clecking
‘i’ DIFF_SYSCLK Systern Clock Differential (positive) 1 AM21 ovDD
DIFF_SYSCLK_B Systern Clock Differential (negative] I AN21 ovDD
RTC Real Time Clock I 319 ovDD
SYSCLK System Clock I AP21 ovDD

Remove selected
peripheral

Figure 6. Assigned Modules panel

The PinMuxing tool not only allows you to assign/unassign peripherals, but also individual peripheral pins. To assign a pin
of a peripheral, expand the peripheral node in the Modules panel and assign the pin similar to assigning a peripheral.

1.3.2.3 Eliminated Modules panel
This panel provides a list of peripherals that can no longer be assigned, as some of the pins they need to operate are
being used by the assigned peripherals.

The eliminated peripherals correspond to the gray items in the Modules panel list. Place the mouse over an eliminated
peripheral to find the assigned peripherals it conflicts with (it means, it needs pins that being used by assigned peripherals).

NOTE
The peripherals colored in yellow in the Eliminated Modules panel are the ones eliminated by the
last assigned peripheral (see the Assigned Modules panel).

The figure below shows an overview of the Eliminated Modules panel.

Eliminated peripheral with pin details

Eliminated Modules

Hover Mame Description Direction Location Power Supply

mouse t0  ————= GPIO General Purpose Input/Output

see conflicts . I2C e

4 5PI SPIInterface

SPLPCS0 SPI Chip Select 10 B7 ovDD
SPLPCSL SPI Chip Select 0 7 avDD
SPLPCS2 SPI Chip Select 0 = ovDD
SPLPCS3 SPI Chip Select 0 co avDD
SPLPCS4 Chip Select 4 0 K5 ovoD
SPLPCSS Chips Select 5 0 L5 avDD
SPLSCK SPI Clock 10 A7 ovoD
SPI_SIMN Master In Slave Out 1 AS ovDD
SPLSOUT Master Out Slave In Q0 AR ovDD

Figure 7. Eliminated Modules panel

1.3.2.4 Toolbar buttons

The PinMuxing component GUI has a toolbar that contains buttons for performing various actions on the GUI.

The actions include:

QCVS PinMuxing Tool User Guide, Rev. 4.7, 10/2016
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* Undo/redo the last operation

* Remove all the assigned peripherals. Clicking the button resets the peripherals to the selectable state.

NOTE
This action resets the undo/redo operations (it means, you will not be able to undo or redo the last
operation).

* Generate a PinMuxing report. Clicking the button generates in XML format a report showing all the pins used by the
assigned peripherals.

* Change the peripheral view mode. Clicking the button performs switching between short and extended peripheral
names.

The figure below shows an overview of the toolbar buttons of the PinMuxing component GUI.

Redo the last

! Generate a
operation PinMuxing report
Undo the last . A ’ P Change the
ndo the las . O " peripheral view
operation { }‘ \/ '_i -’ mode

Remove all the
assigned peripherals

Figure 8. Toolbar buttons

NOTE
In each of the Modules, Assigned Modules, and Eliminated Modules panels, you can expand a
peripheral node and see the details of each pin associated with the peripheral (such as pin name,
description, direction, location, and power supply). The pin details displayed in these panels can
be changed using the View Mode toolbar button (last button in the figure above).

1.3.3 Adding a new PinMuxing component to a project

This section explains how to add a new PinMuxing component to an existing QCVS project.

You can work in parallel with multiple PinMuxing components (note that only one PinMuxing component can be active at a
time). To add a new PinMuxing component to an existing QCVS project, follow the steps below:

1. Open the Components Library view by choosing Window > Show View > Components Library from the Eclipse
IDE menu bar.

2. Right-click the PinMuxing component and choose Add to project on the Categories or Alphabetical page, as shown
in the figure below.

QCVS PinMuxing Tool User Guide, Rev. 4.7, 10/2016
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% Component Inspector - Pinbuwel % Components Library 23

Categories | Alphabetical . Assistant | Processors

Component Level

Device Configura...
Device Configura...
Device Configura...
Device Configura...
Peripheral Initiali...
Device Configura...

Component
i} BOOTROM
iif DDR
iiF DPAA
i HWDeviceTree
i PEL
o] Pinhduee
'ﬂ Pin! E Add to project
i Serl Add to project with Wizard
Expand all
Collapse all
Refresh
W Delete

Help on Component

F5
Delete

Pevice o,
Device Configura...

Add new PinMuxing
component to the project

Figure 9. Add a PinMuxing component to an existing project

1.3.4 Generating a PinMuxing report

After you have assigned all the peripherals, you can generate a PinMuxing report.

To generate the PinMuxing report, click the second button from right in the PinMuxing component GUI toolbar. The generated
PinMuxing report provides the following information:

» Assigned peripherals along with the associated pins and their properties (name, package location, direction)

* Eliminated peripherals along with the associated pins and their properties (name, package location, direction, power)

The PinMuxing report is generated in the following two formats:

e HTML: This format is more human readable

* XML: This format is useful for automatic processing

The figure below shows a sample PinMuxing report.
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Pin Muxing Configuration <& R e B
Modules = Assigned Modules =l
Name Description Direction Location Pe* Name Description Direction Location Pcf=
: Analog-Signals Analog Signals E » DFT DFT il
> Clocking Clocking B P — = L S— b
. DDR-Interface-1 DDR SDRAM Memary Interface 1 Himinated Modul
» DFT DFT minat ules =
> DUART DUART Name Description Direction  Location  Pc *
> ECL Ethernet Controller 1 GPI0 G Ip I Output
> EMIL Ethemnet Management Interface 1 o> g — "iﬂera urpose Input/Outpul i
< | [ 3 1| n 3
(@ PinMux Report 52 = 0
B & filey///C:/Users/bA6102/Documents/devtech.gevs/ runtime-hew_configuration/Is1012/Generated_Code/pinmux_report.html - B

Table 1: Assigned Modules

Signal Details

Module Name
FTM2_CHO Channel 0 O1vDD Open Drain 1
FTM2_CH1 Channel 1 10 63 Q1vDD
FTM2
FTM2_CH2 Channel 2 10 64 Q1vVDD L3
FTM2_CH3 Channel 3 o] 127 Q1vVDD
DFT SCAN_MODE_B Reserved | 66 Q1vDD

Table 2: Eliminated Modules

Signal Details

mDind N1 rmaral Diirmaes Inmd O e AMN

Module Name

Figure 10. Sample PinMuxing report
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